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Preface

The Purpose of This Book
This book explains what Cachelink® Pro and Cachelink Connector do, how they work, how to 
install and customize them, and how to monitor the time and bandwidth they can save you. 

Audience
This book is intended for people who install, configure, and use Cachelink Pro or Cachelink 
Connector.

Revision Information
This is a new book.

What’s in This Book 
This book contains the following chapters and appendixes:

• Chapter 1, ‘‘Introduction to Cachelink” - Describes the basic features of Cachelink Pro
Cachelink Connector, and introduces their user interfaces.

• Chapter 2, ‘‘Viewing Performance Information” - Explains how to monitor Cachelink 
activity on your system, and on other systems running the software.

• Chapter 3, ‘‘Customizing Cachelink” - Shows how to tailor Cachelink to meet any spec
requirements your site may have.

• Appendix A, ‘‘Installing Cachelink Pro from a Kit” - Describes how to install Cachelin
Pro from a kit. A majority of users install Cachelink Pro in this manner.

• Appendix B, ‘‘Cachelink Pro Network Installation and License Management” - Descri
how to prepare and execute a Cachelink Network Installation and manage Cachelink
licenses.

• Appendix C, ‘‘Cachelink Connector Overview, Installation, and Configuration” - 
Describes how Cachelink Connector works, and also how to install Cachelink Conne
and configure Connector client systems to reap Cachelink’s benefits.

Technical Support
Mangosoft Technical Support offers assistance for problems you cannot solve on your ow
case of a system problem, determine whether the system has been properly operated an
that all system components are operational. 
vii



If the problem persists, access the online help for troubleshooting information. If this does not 
help resolve your problem, look in the directory where you installed Cachelink and view the 
readme.txt (readme) file and the relnotes.txt (release notes) file. 

You can also access the support area on the Mangosoft web site at 
www.mangosoft.com/support. You can view information on late-breaking issues and solutions 
here.

If your problem persists, send electronic mail to technical support at: support@mangosoft.com. 
Mangosoft will respond to your message as quickly as possible. To help Mangosoft Technical 
Support diagnose and resolve the problem more quickly, please include the following 
information in your electronic mail message:

• The case number, if you are calling about a previous problem

• Your name

• Your telephone number

• Your company name and location (city, state or province, and country)

• Information about the computer experiencing the problem, including the type and version 
of operating system, and the type and version of Mangosoft application you are running.

• A detailed problem description:

- Describe the symptom and the activities that preceded it.

- Be as specific as possible.

- Briefly describe your trouble-shooting steps and observations.

With the above information, many problems can be diagnosed and resolved quickly by 
Mangosoft Technical Support representatives.

How to Comment on Cachelink
At Mangosoft, our goal is to provide the highest quality products and services to our customers. 
We value customer feedback and encourage users of Mangosoft applications to send their 
comments on our products, services, and documentation to our Technical Support Department, 
so that we can continue to improve our products.

Please send your comments and suggestions, including features you would like to see in future 
releases, to the following address:

Technical Support Department

Mangosoft, Inc.

1500 West Park Drive, Suite 190

Westborough, Massachusetts 01581 USA
viii Cachelink User’s Guide  
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Chapter 1
Introduction to Cachelink1-

Many Web browsers provide a Web cache that resides on your own computer’s hard drive. This 
cache stores Web page information (text, graphics, sounds, downloads, and the like) for the 
Web pages you have visited. Unfortunately, without Cachelink®, the browser caches on 
different computer systems do not work together. If you visit a page and then a co-worker visits 
the same page, they’ll have to wait - just like you did - for the page to download from the 
Internet.

The Cachelink family of products combines the individual browser caches on the computers on 
your LAN into a highly efficient, LAN-wide Web-cache without the need for any additional 
hardware. Web pages accessed by one Cachelink user are instantly available to other Cachelink 
users, saving time. By allowing Web pages to be stored and shared, Cachelink saves Internet 
bandwidth so that more is available for other applications and users.

Cachelink Pro and Cachelink Connector run on Windows-based computers on your local area 
network (LAN). Now in its third generation, Cachelink works with new or existing networks of 
Windows 95, Windows 98, Windows NT, Windows ME, and Windows 2000 systems.

• The Cachelink Pro software runs on a Windows computer and stores browsed Web pages 
on the PC. When another computer running Cachelink browses to the same Web page, the 
other computer can get the stored information locally from the nearby computer, rather than 
going out to the Internet to retrieve it.

• The Cachelink Connector software runs on a Windows computer and stores browsed Web 
pages on the PC. Cachelink Connector enables non-Windows computers that are 
configured as Cachelink clients to use the Connector system’s resources to store and
Web pages, allowing them to take advantage of Cachelink savings.

This chapter introduces you to Cachelink Pro and Cachelink Connector and contains the
following sections:

• ‘‘What Cachelink Products are Available?”

• ‘‘Cachelink Benefits”

• ‘‘Cachelink Terms”

• ‘‘The Cachelink User Interface”
Introduction to Cachelink 1-1
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What Cachelink Products are Available?
There are two products in the Cachelink family: Cachelink Pro and Cachelink Connector.

Cachelink Pro
Cachelink Pro is installed on each Windows-based computer on a local area network. As 
computer users browse the Internet, the Web site data they download is cached on their local 
computer, and made available to other computers on their LAN that are also running Cachelink.

A performance analyzer Web application enables users to view information about how much 
time and bandwidth Cachelink is saving them. An activity meter is available which displays 
current information on Cachelink activity and speed. The network installation feature enables 
System Administrators to simplify and standardize installation at large sites. In addition, this 
feature enables centralized license management.

N O T E

Cachelink Pro is shipped with some hardware products as a 
performance improvement tool. These OEM versions of 
Cachelink provide all of Cachelink’s savings, but may not 
include all of its features.

Cachelink Connector
Cachelink Connector is installed on a Windows-based computer, and allows 
non-Windows-based computers (such as Linux or Mac systems) to take advantage of 
Cachelink's benefits. Data from any Internet sites browsed by a non-Windows client com
is stored on the Cachelink Connector computer. Once cached, as with other Cachelink sy
Web data is made available both to other non-Windows Cachelink Connector clients, an
Windows-based computers on the same LAN that are running Cachelink Pro.

Cachelink Connector is intended to complement a new or existing installation of Cachelink
ensuring that non-Windows computer users can experience the same benefits that Cache
yields to Windows users.
1-2 Cachelink User’s Guide 
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Cachelink Benefits
Cachelink Pro leverages your LAN to provide ultra-fast Internet access. Cachelink Connector 
allows you to extend your Cachelink savings to non-Windows computers, providing you with 
additional time and bandwidth savings.

The following sections describe Cachelink’s key benefits.

Web Acceleration for Internet Connections of Any Speed
Cachelink retrieves commonly viewed Web pages from other Cachelink users on your L
instead of through the Internet. Cachelink enhances Web performance in the following w

• Because your LAN is much faster than your Internet connection, accessing cached content 
within your LAN is much faster than accessing it over the Internet, even with the fastest 
Internet connections. Even a slow LAN (10Mbps) is far faster than a T1 (1.544Mbps) or 
DSL Internet connection (currently 144K to 640K) for delivering content. 

• By avoiding congested Web servers and congested links on the Internet, accessing cached 
content within your LAN reduces the impact of slow Web servers and slow Internet links. 
If the Web servers you access are slow, the speed of your Internet connection is irrelevant. 
Besides, accessing the same content over and over from a slow server just makes that server 
slower. Cachelink reduces the amount of time that you wait for slow servers and reduces 
the amount that you over-load those servers.

• By avoiding reloading the same content over your Internet connection, more of your 
Internet connection’s bandwidth is available for downloading new pages or for other 
Internet applications, such as e-mail, Internet telephony, or streaming media. Cachelink 
makes efficient use of your Internet connection, making more bandwidth available for more 
effective use of the Internet by more users on your network.

• Cachelink combines the browser caches with only a trivial amount of additional LAN 
traffic, typically a small fraction of one percent of active Web traffic.

Web Acceleration for Networks of Any Size
Each time you install Cachelink on an additional computer on your LAN, it adds computing 
power and cache space to the Cachelink Web cache pool. This pool represents all of the 
Cachelink Web caches on each computer that, combined, provide all of the locally stored Web 
content that Cachelink computers can access. Based on Mangosoft’s patented pooling 
technology, Cachelink provides high performance for networks, regardless of the number of 
computers they connect.

Secure and Private Caching
Cachelink combines your browser caches securely to maintain your privacy. Cachelink 
maintains your privacy in the following ways:
Introduction to Cachelink 1-3



Cachelink Benefits
• Content that you browse is stored only on your PC. This prevents another user from 
determining your access patterns by viewing your portion of the Cachelink cache on their 
PC. The only content that will be on their PC is content that they downloaded themselves. 

• Cachelink is an anonymous cache - it respects your privacy and does not provide tools to 
monitor user activity. Cachelink maintains security by what it doesn’t do - it does not cache 
content passed over secure connections (HTTPS). Caching such content would make it 
vulnerable to unauthorized access. By not caching this information, Cachelink cannot 
compromise personal data sent over secure connections.

Ease of Use and Installation
Cachelink Pro and Cachelink Connector provide a fast, straightforward installation kit, and 
require no additional hardware. Unlike proxy servers or Web-cache hardware, there’s no need 
to manually reconfigure complex browser connection settings. 

The Cachelink installation program automatically configures popular browsers to use Cachelink 
when it finds popular browsers that are installed on your computer, and set up to browse the 
Web. Auto-configurable browsers include Internet Explorer versions 4, 5, and 6 and Netscape 
versions 4.0, 4.5, 4.6, 4.7, and 6.0. Other browsers can be manually configured to use Cachelink 
the same way they are configured to use any proxy server.

Optimized Cache Usage
To ensure that cache use is optimized, Cachelink detects when Web content is outdated. A Web 
page developer provides expiration dates for Web content. If a graphic, download, movie, 
animation, or other Web item has expired, the next time someone tries to access a Web page 
containing that content, the content is refreshed from the Internet with updated information. 
This updated content is then made available in the cache for all to access.

Each user can specify the maximum size their cache can attain. Should the cache reach that size, 
Cachelink continues to add newly-accessed information, overwriting the information that has 
been stored in the cache the longest.

Reliable Caching with No Single Point of Failure
Unlike centralized proxy servers or Web-cache hardware, Cachelink Pro has no single point of 
failure. When a centralized proxy server fails, all Web access is interrupted; when an expensive 
Web-cache hardware box fails, access to 100% of cached content is interrupted. If one of 100 
nodes running Cachelink Pro fails, only 1% of your distributed cache fails - the remaining 99% 
continues to operate and provide its benefits to all available Cachelink systems.
1-4 Cachelink User’s Guide 
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N O T E

If Cachelink Connector fails, its non-Windows client computers 
will be unable to access the Internet. Modifying their proxy 
server settings can quickly remedy this problem.
Introduction to Cachelink 1-5
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How Does Cachelink Work?
Cachelink Pro shares cached trinkets (Web information) between all computers running 
Cachelink on your local area network (LAN). When a computer running Cachelink browses a 
Web page, the Web items on that page are stored in that computer’s Web cache. If another 
Cachelink computer on the LAN browses to that same Web page, the page is retrieved from 
storage on the first Cachelink computer, rather than from the Internet. The more computers 
running Cachelink, the more Web information is cached and made available to all users.

Cachelink Connector allows a Windows-based system to provide Cachelink’s full caching
cache-sharing functionality to non-Windows computers.

N O T E

For information on how Cachelink Connector works, see 
Appendix C, ‘‘Cachelink Connector Overview, Installation, 
and Configuration.”
1-6 Cachelink User’s Guide 
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Cachelink Terms
Before looking further into understanding how Cachelink works, it is important to understand a 
few key terms: Web cache, trinket, and pool.

What is a Web Cache?
A Web cache is a place where Web pages that you have visited are stored so that they can be 
displayed quickly when you visit those Web pages again. Rather than having to wait to 
download the same page over and over, a Web cache returns loaded pages quickly without 
clogging your Internet connection. This has two major benefits: 

• Pages you have visited can be displayed more quickly when you visit them again.

• New pages can load faster because your Internet connection is not bogged down by 
reloading the same content.

Cachelink makes your browser caches work together. Web pages visited by any Cachelink user 
are made available quickly and securely to every Cachelink user on the LAN. 

What is a Trinket?
When you browse a Web page, many pieces of information are downloaded from the Internet 
to form that page. Animations, graphics, sounds, pieces of text, files, and scripts may be 
included. Cachelink calls all of these items trinkets. When running Cachelink, if you browse to 
a Web site and no other Cachelink user has visited it, all of the items that comprise the page, or 
trinkets, will be stored in your Cachelink cache. When a user on another computer browses to 
that Web page, Cachelink will attempt to locate the trinkets that make up that page on a local 
computer that is also running Cachelink. When they are found in your cache, the trinkets are 
retrieved from your computer, and displayed as a complete Web page for the other user.

What is the Cachelink Pool?
Pioneered by Mangosoft, pooling is a networking solution that is adaptive, transparent, and 
automatic. Using advanced caching and virtual memory techniques, pooling unifies the memory 
and disk resources of networked computers to speed information access.

Pooling technology automatically moves files to users that need them, so access happens 
locally, and network performance increases. When each Cachelink user has Web items, or 
trinkets, stored in their cache, their caches are said to form a Cachelink pool. Their resources 
are pooled, or shared, making every Web trinket any Cachelink user has stored available to 
every other Cachelink user. The more people browse, the more trinkets are cached, and the more 
information is available for local retrieval.
Introduction to Cachelink 1-7
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The Cachelink User Interface
Cachelink works seamlessly in the background, enabling you to quickly access the information 
you need. Cachelink has a readily available user interface that allows you to monitor Cachelink 
and modify its settings. This section describes Cachelink’s user interface.

The System Tray Icon
You will find the Cachelink icon in the system tray. By default, the system tray appears a
lower right-hand corner of your computer’s screen, and computer programs on your system
display small icons in this area. The Cachelink icon shows the outline of an orange and g
mango. If you right-click the icon, you can choose any of the following options from the ico
pop-up menu:

• Activity Meter - launches the Activity Meter on systems running the retail version of 
Cachelink Pro. You can also launch the Activity Meter by double-clicking the tray icon.

• Configuration - launches the Cachelink Configuration Utility.

• Performance Analyzer - displays the browser-based Cachelink Performance Analyzer.

• Help - launches the online help.

• About Cachelink - provides you with information about the Cachelink product installed on 
your computer.

The Activity Meter
The Cachelink Activity Meter (available on systems running the retail version of Cachelink Pro) 
enables you to view Cachelink activity on your computer in real-time. You can view details 
about how quickly information is delivered to your computer from Cachelink or the Internet, 
and you can see graphic representations of the access speed and response time. The Activity 
Meter is described in detail in Chapter 2.

The Browser-Based Performance Analyzer
The browser-based Cachelink Performance Analyzer provides detailed information on how 
much time has been saved by using Cachelink, and information on cache storage and usage. 
This information can be displayed for just your computer system, for another computer on your 
LAN, or for all Cachelink computers. You can view information on the savings by computer 
system, or as an aggregate of all computers on the LAN that are running Cachelink. The 
Performance Analyzer is described in detail in Chapter 2.

The Cachelink Configuration Utility
Cachelink’s default settings meet the needs of many Cachelink users. However, when u
Cachelink, there may be aspects of the application's functionality that you want to chang
customize your Cachelink configuration, you can launch the Cachelink Configuration Utilit
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choosing Start > Programs > Cachelink > Configuration, or by right-clicking on the Cachelink 
icon and choosing Configuration from the icon’s pop-up menu.

This configuration utility allows you to modify what browsers use Cachelink on your compu
the size of your cache, proxy server settings, and so forth. The Cachelink Configuration U
has four tabs, or screens: the General tab, the Web Browsers tab, the Cache tab, and th
Advanced tab.

Additional information about the Configuration Utility and its uses can be found in Chapte
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Chapter 2
Viewing Performance Information2-

Cachelink® works seamlessly in the background, day in and day out, caching and delivering 
Web content among the various Cachelink computers on your network. If you want to find out 
about your Cachelink savings or view other Cachelink information, you can view it as described 
in this chapter.

This chapter contains the following sections:

• ‘‘The Browser-Based Performance Analyzer”

• ‘‘Activity Meter Window”

• ‘‘Verifying Cachelink’s Operational Status”

N O T E

The Cachelink Activity Meter is only available on retail 
versions of Cachelink Pro.
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The Browser-Based Performance Analyzer
Cachelink’s Performance Analyzer provides information on the benefits of Cachelink to all 
users on your network. Easy-to-read graphs and charts show you detailed information on 
Cachelink’s performance. 

When Cachelink stores information you have viewed on the Internet, it stores the inform
as individual items, also called trinkets. These trinkets can be small or large, and could co
text, graphics, downloads, animation files, and the like. When a Cachelink user browses
Web page that another user has already visited, the trinkets that comprise that Web pag
retrieved from a local machine for display.

As Cachelink users browse the Internet, their systems quietly cache content to share with
Cachelink users. Their cache content is pooled, and for this reason, the caches, seen to
are called a cache pool.

The Performance Analyzer displays information about Cachelink’s performance and sav
The displays describe information about trinkets (Web items) that have been accessed, 
they were accessed from (the local Cachelink pool or the Internet), how long it took to ac
them, and how much space they are taking in your computer’s cache (the amount of spac
computer is using for trinkets or contributing to the Cachelink pool).

The Performance Analyzer takes a snapshot of Cachelink's performance data since Cac
was installed (data gathering begins as soon as Cachelink is installed on a computer on
LAN). The time that the data snapshot was taken is shown at the bottom of the display. T
Cachelink computers that have provided performance data are listed on the left side of t
display. You can select from multiple views from the drop-down box at the top of the scre

N O T E

Since Cachelink Connector Clients are not actively running 
Cachelink, they are not listed on the Performance Analyzer. But 
since all of their caching is done by the Cachelink Connector 
System, all of the Cachelink data on the clients’ aggregate 
activities is displayed as information for the Connector System.

The rest of this section describes the following:

• ‘‘Displaying the Access Time and Hit Counters View”

• ‘‘Displaying the Time and Bandwidth View”

• ‘‘Displaying the Cache Usage View”
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Displaying the Access Time and Hit Counters View
This view is the first view you see when you launch the Performance Analyzer (Figure 2-1).

Figure 2-1: Performance Analyzer - Access Time and Hit Counters View

The Pooled Hits multiplier in the center of the view displays how much faster pooled local data 
was obtained than Internet data. This multiplier appears if the Pooled Hits were at least twice as 
fast as the Internet Hits.

This view compares information on where trinkets (Web items) were acquired, displaying:

• The number of times content was downloaded from the Internet (Internet Hits).

• The number of times content was acquired from the Cachelink cache on other computers 
(Pooled Hits).

• The number of times content was loaded from Cachelink’s Web cache on your comp
(Local Hits). This is locally-stored information that would have been stored by your 
browser and displayed quickly even without Cachelink.
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To display the Access Time and Hit Counter view of the Performance Analyzer:

1. Launch the Performance Analyzer in one of the following ways:

• Right-click the Cachelink icon (an orange and green mango in the system tray at the 
lower right of your screen), and choose Performance Analyzer from the pop-up menu.

• Choose Start > Programs > Cachelink > Configuration, and click the Performance 
Analyzer button on the General tab.

2. Your computer browser opens a Web page showing the Access Time and Hit Counters 
view. By default, aggregate information is shown for all computers running Cachelink on 
this LAN.

3. To choose a system whose performance information you want to view, click to select an 
item in the list on the left side of the page. You can choose All Computers to see 
information for all systems running Cachelink on the LAN, or you can select a specific 
computer to view its information.

N O T E

Since the Connector System performs all caching activities for 
Connector Clients, you can view the aggregate information for 
a Cachelink Connector System and all of its clients by choosing 
to view data for the Connector System alone.

4. You can view how Cachelink activity and savings vary among computers by sorting the 
systems using the Sort By list box at the top left of the view. If you choose to sort on a 
specific characteristic, you will notice the order of the computers listed below changes to 
reflect your selection. This can help you compare how different computers are benefiting 
from Cachelink.

Click an individual computer to view its information.

You can sort by the following data:

• Computer Name - Sorts the computers alphabetically by name (the default setting).

• Pool Speed Ratio - Sorts the computers in descending order according to the ratio of 
how long it took to access Pooled Hits from Cachelink, compared with how fast it took 
to obtain the same content from the Internet (Internet Hits). If the ratio multiplier is less 
than two, this data will not appear.

• Pooled Average Time - Sorts the computers in descending order based on the average 
time it took to obtain trinkets from the Cachelink Pool.

• Internet Average Time - Sorts the computers in descending order based on the average 
time it took to obtain trinkets from the Internet.
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• Local Average Time - Sorts the computers in descending order based on the average 
time it took to obtain trinkets from the computer’s own Cachelink cache, resulting
extremely fast access times.

• Pool Hits - Sorts the computers in descending order based on the number of pooled hits 
(hits from another computer’s Cachelink cache).

• Cache Misses - Sorts the computers in descending order based on the number of 
Internet hits (cache pool misses).

• Local Hits - Sorts the computers in descending order based on the number of local hits 
(retrieval of data already stored in this computer’s Cachelink cache) the system 
encountered.

N O T E

Note that, because the Connector Clients only store trinkets on 
the Connector Systems, all client hits on the Connector System 
will look like local hits on the Connector System.

5. Click Refresh on your Web browser to access and display the latest information.
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Displaying the Time and Bandwidth View
Time and traffic savings are shown in the Time and Bandwidth view (Figure 2-2).

Figure 2-2: Performance Analyzer - Time and Bandwidth View

Time savings are calculated by comparing the time spent downloading Web content from the 
Cachelink cache pool with the time spent downloading that same content when it was initially 
downloaded from the Internet. 

Keep in mind that the actual speed of your Internet access is not only affected by the speed of 
your Internet connection, but also by the level of congestion along the route between your 
computer and the target Internet server, and the speed of the Web server itself.

Traffic savings are calculated by taking the amount of content fetched from the Cachelink pool 
(pooled hits), and presuming that this content would have been obtained from the Internet if 
Cachelink were not installed.
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To display the Time and Bandwidth view:

1. Launch the Performance Analyzer in one of the following ways:

• Right-click the Cachelink icon (an orange and green mango in the system tray at the 
lower right of your screen), and choose Performance Analyzer from the pop-up menu.

• Choose Start > Programs > Cachelink > Configuration, and click the Performance 
Analyzer button on the General tab.

2. Your computer browser opens a Web page showing the Access Time and Hit Counters 
view. Click on the drop-down arrow of the Display list-box and choose Time and 
Bandwidth. By default, aggregate information is shown for all computers running 
Cachelink on this LAN.

3. If you want to view information for a specific computer, click to select a system in the list 
on the left side of the page. 

4. You can view how time and bandwidth usage varies among computers by sorting the 
systems using the Sort By list box at the top left of the view. If you choose to sort on a 
specific characteristic, you will notice the order of the computers listed below changes to 
reflect your selection. This can help you compare how different computers are benefiting 
from Cachelink.

You can sort by the following data:

• Computer Name - Sorts the computers alphabetically by name (the default setting).

• Time Savings - Sorts the computers in descending order based on their time savings 
due to Cachelink. Look at the value on top of the Time Savings columns to see the 
individual values for the time spent downloading Web trinkets without Cachelink, 
versus the time with Cachelink.

• Traffic Savings - Sorts the computers in descending order based on their traffic savings 
from Cachelink. Look at the value on top of the Traffic Savings columns to see the 
individual values for the network traffic generated by browsing without Cachelink, 
versus the traffic with Cachelink.

5. Click Refresh on your Web browser to access and display the latest information.
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Displaying the Cache Usage View
Cache space information is shown in the Cache Usage view (Figure 2-3).

Figure 2-3: Performance Analyzer - Cache Usage View

Cache Space shows the currently configured size of the maximum space that could be 
contributed by all Cachelink computers for Cachelink caching. When you designate cache space 
on a Cachelink system, note that the space is not immediately allocated and used. Rather, you 
designate a maximum size and the cache is allowed to grow to that size as needed. Once a 
computer’s cache reaches the maximum size, the items that were cached first are remov
needed to make room for new Web trinkets. 

Each computer’s cache contribution is shown as a percentage of the total cache. This vie
shows the amount of the combined cache that is currently in use, and currently free. In ad
you can view the number of trinkets (Web items) that have been served from the cache.

Note that you can modify the cache settings for a computer running Cachelink on the Cac
Configuration Utility’s Cache tab. See Chapter 3 for more information about cache settin
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To display the Cache Usage view:

1. Launch the Performance Analyzer in one of the following ways:

• Right-click the Cachelink icon (an orange and green mango in the system tray at the 
lower right of your screen), and choose Performance Analyzer from the pop-up menu.

• Choose Start > Programs > Cachelink > Configuration, and click the Performance 
Analyzer button on the General tab.

2. Your computer browser opens to a Web page showing the Access Time and Hit Counters 
view. Click on the drop-down arrow of the Display list-box and choose Cache Usage. By 
default, aggregate information is shown for all computers running Cachelink on this LAN.

3. If you want to view information for a specific computer, click to select a system in the list 
on the left side of the page. 

4. You can view how cache usage and cache contribution varies among computers by sorting 
the systems using the Sort By list box at the top left of the view. If you choose to sort on a 
specific characteristic, you will notice the order of the computers listed below changes to 
reflect your selection. This can help you compare how different computers are contributing 
space to the Cachelink cache pool.

You can sort by the following data:

• Computer Name - Sorts the computers alphabetically by name (the default setting).

• Configured Space - Sorts the computers in descending order based on the disk space 
they have specified as their maximum cache size.

• Used Space - Sorts the computers in descending order based on the actual space that is 
currently used to store cached trinkets.

• Free Space - Sorts the computers in descending order based on the amount of 
designated cache space that is currently available.

• Trinkets - Sorts the computers in descending order based on the number of stored 
trinkets.

• Trinkets Served - Sorts the computers in descending order based on the number of 
trinkets that have been served from its cache.

• Trinkets Server/Second - Sorts the computers in descending order based on the rate at 
which trinkets have been served from its cache.

5. Click Refresh on your Web browser to access and display the latest information.
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Activity Meter Window
The Cachelink Activity Meter provides you with an indication of how Cachelink is working on 
your computer. It tells you what Cachelink is doing, how quickly Cachelink retrieves Web data, 
and whether Cachelink retrieved Web trinkets from the Internet or from the Cachelink cache on 
another computer.

N O T E

The Cachelink Activity Meter is only available on retail 
versions of Cachelink Pro.

To launch the Activity Meter, do one of the following:

• Double-click the Cachelink icon (the orange and green mango in the system tray at the 
lower right of your screen).

• Right-click the Cachelink icon, and choose Activity Meter from the pop-up menu.

• Choose Start > Programs > Cachelink > Configuration, and click the Activity Meter button 
on the General tab.

Unlike the Performance Analyzer, the Activity Meter only displays information about the 
specific computer on which it is viewed.

The Activity Meter shows performance information gathered since the last time Cachelink was 
started. If you restart your computer, the meter resets. 

If you have only accessed Cachelink cache hits since the software restarted, you will see only 
green on the charts. If you have only accessed Internet or Intranet information, you will only see 
orange on the charts, indicating that you are not browsing any Web sites that other Cachelink 
users have browsed. If no activity is displayed by the Activity Meter while you are browsing, 
this indicates that your browser is obtaining data from the Web cache on your computer.

You may notice that the Activity Meter display exits automatically when Cachelink restarts. 
Cachelink restarts automatically approximately twice a day, and also restarts when you delete 
your Cachelink cache or reboot your computer. If the Activity Meter display exits, you can 
redisplay it as described above.
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Displaying Speed Information
The Cachelink Activity Meter by default displays access speed information. If you are viewing 
the Activity Meter and speed data does not appear, choose View > Display > Speed from the 
meter’s menu bar.

N O T E

The Cachelink Activity Meter is only available on retail 
versions of Cachelink Pro.

The Activity Meter’s Speed view is shown in Figure 2-4.

Figure 2-4: Activity Meter - Speed View

The Speed view shows the following:

• Speed Multiplier - This number appears at the far right of your screen, and indicates how 
many times faster Cachelink’s peak speed is than the Internet’s peak speed.

• Status - The status indicates what Cachelink is currently doing. 

• Idle - You are not currently browsing the Internet. 

• Retrieving - Your computer is obtaining Web trinkets from a local Cachelink 
computer.

• Waiting for the Internet - Your browser is getting trinkets from the Internet.

• Saving to Cachelink - After retrieving new trinkets from the Internet, your system 
caches this data so that it will be available to other Cachelink computers.

• Peak Cachelink Speed - The top speed at which Cachelink retrieved trinkets from another 
computer running Cachelink on your LAN.
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• Peak Internet Speed - The top speed at which Cachelink retrieved trinkets from the Internet. 
This speed reflects data retrieved from any Web site, whether it’s on the Internet or y
Intranet.

• Legend - The legend indicates the colors used in the chart - green for Cachelink, orange for 
Internet. It also explains that, for the Speed view, taller bars indicate a faster speed.

• Speed History - This display shows you information about where and how fast information 
was retrieved. Green bars indicate the information was retrieved from a Cachelink cache 
on another computer on your LAN. Orange indicates the information was retrieved from a 
Web server on the Internet or Intranet. A peak value is also displayed above the chart.

Displaying Delay Information
You can also view Delay data to see how long information takes to access using your Web 
browser. To view Delay information, choose View > Display > Delay from the meter’s me
bar. 

N O T E

The Cachelink Activity Meter is only available on retail 
versions of Cachelink Pro.

The Activity Meter’s Delay view is shown in Figure 2-5.

Figure 2-5: Activity Meter - Delay View

The Activity Meter’s Delay view displays the following:

• Speed Multiplier - This number appears at the far right of your screen, and indicates how 
many times faster Cachelink’s peak speed is than the Internet’s peak speed.

• Status - The current Cachelink status.

• Idle - You are not currently browsing the Internet. 

• Retrieving - Your computer is obtaining information from a local Cachelink computer.
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• Waiting for the Internet - Your browser is getting Web trinkets from the Internet.

• Saving to Cachelink - After retrieving trinkets from the Internet, your system caches 
this data so that it will be available to other Cachelink computers.

• Peak Cachelink Delay - This shows the peak delay for trinkets delivered from the Cachelink 
cache in another Cachelink computer on your LAN.

• Peak Internet Delay - This speed indicates the peak delay for trinkets obtained from the 
Internet.

• Legend - The legend labels the colors used in the chart - green for Cachelink, orange for 
Internet. It also explains that, for the Delay view, shorter bars indicate a faster speed.

• Delay History - This display shows you information about where trinkets were retrieved, 
and the response time to obtain them. Green bars indicate the information was retrieved 
from a Cachelink cache on another computer on your LAN. Orange indicates the 
information was retrieved from a Web server on the Internet or Intranet. A peak value is 
also displayed above the chart.

Customizing the Activity Meter Window
There are a number of menu options on the Activity Meter that allow you to customize this small 
but powerful display.

N O T E

The Cachelink Activity Meter is only available on retail 
versions of Cachelink Pro.
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You can use these menu options as described in Table 2-1:

Table 2-1: Activity Meter Menu Options

Menu > Option Result

Options > Always On Top When selected (checked), this ensures the Activity Meter is always 
displayed on your screen (never obscured by other windows). When 
deselected (unchecked), the meter may be covered by other 
windows.

View > Refresh Now Refreshes the display with the most recent information.

View > Update Speed Allows you to set the speed at which the meter’s display is 
refreshed. Choose from the following rates:

• High - every half second

• Normal - every second

• Low - every five seconds

• Paused - information is not refreshed

View > Reset Resets the view so all displays revert to 0.

View > Display You can choose what types of information you want shown. You can 
choose whether you want to view Speed or Delay data.

• Speed displays how quickly Web trinkets are retrieved from a 
Cachelink cache or the Internet, measured in Kbps (Kilobits per 
second), showing the raw speed of information delivery.

• Delay shows how quickly each piece of information that is being 
displayed was delivered, measured in milliseconds per Kilobyte.

View > Performance Analyzer Launches the browser-based Performance Analyzer. If you want, 
you can bookmark this Web page for easy access through your Web 
browser.

Help > Activity Meter Help Launches the Activity Meter help topic, and provides access to the 
Cachelink online help system.

Help > Cachelink Help Launches the Cachelink help system, and displays the help 
contents.

Help > About Cachelink Displays information about this particular version of Cachelink.
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Verifying Cachelink’s Operational Status
To check Cachelink’s operational status:

1. Choose Start > Programs > Cachelink > Configuration to launch the Cachelink 
Configuration Utility.

2. Click the General tab.

3. View the Status information on the tab. The Cachelink status should always be Running. If 
the Cachelink status is Not Running, click the Start Cachelink button to start it.

Checking Cachelink Pro Operation
If you notice your Web access is slow, and you suspect Cachelink is not running, you may want 
to check Cachelink’s status as described above.

Checking Cachelink Connector Operation
If the Connector Clients cannot access the Internet, and you have ensured Cachelink is running 
on the Connector System, check to ensure that:

1. The Connector System is fully operational, available on the network, and able to access the 
Internet. The Clients depend on the Connector System for their Internet access, just as they 
would any Internet proxy server.

2. The Connector Clients can access the Connector System. Go to a client system with access 
problems and attempt to ping the Connector System. If the ping is unsuccessful, resolve any 
network issues which could affect network communications between the systems.

3. The Connector Client’s proxy settings are correct. See the section titled ‘‘Configuring
Connector Clients” in Appendix C for additional information.
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Chapter 3
Customizing Cachelink3-

Cachelink® Pro and Cachelink Connector, as installed, should provide uninterrupted caching 
and information delivery service with no additional customization. However, as you continue 
to use Cachelink, you may want to modify one or more settings to customize the product to your 
changing needs. 

There are several ways that you can customize and configure Cachelink on your computer. Most 
of these customizations are made using the Cachelink Configuration Utility.

This chapter contains the following sections:

• ‘‘The Cachelink Configuration Utility”

• ‘‘Configuring Your Browsers to Use Cachelink”

• ‘‘Displaying or Hiding the Cachelink Tray Icon”

• ‘‘Managing Your Cachelink Cache”

• ‘‘Changing Your License”

• ‘‘Advanced Settings”
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The Cachelink Configuration Utility
You can access the Configuration Utility in two ways:

• By choosing Start > Programs > Cachelink > Configuration.

• By right-clicking the Cachelink icon, and choosing Configuration from the pop-up menu. 
The icon appears in the system tray at the lower right corner of your screen.

The Cachelink Configuration Utility has four tabs that allow you to customize how Cachelink 
works on your computer: the General tab, the Web Browsers tab, the Cache tab, and the 
Advanced tab.

The following sections briefly describe these tabs and their uses:

• ‘‘The Configuration Utility General Tab”

• ‘‘The Configuration Utility Web Browsers Tab”

• ‘‘The Configuration Utility Cache Tab”

• ‘‘The Configuration Utility Advanced Tab”

The rest of this chapter describes in detail how to use the features these tabs provide.
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The Configuration Utility General Tab
The General tab (Figure 3-1) is the left-most tab, and it provides you with basic information and 
settings.

Figure 3-1: The General Tab

N O T E

The Cachelink Connector tab varies slightly from the screen 
shown in Figure 3-1. It omits the Activity Meter button since 
this feature is not available on the Cachelink Connector.

The General Tab allows you to:

• View information about the version of Cachelink that is currently installed.

• View the status of Cachelink, and start it if for some reason it is not running.

• View Cachelink license information for this computer, and modify it if necessary.

• Launch the Activity Meter (only available with the retail release of Cachelink Pro).

• Launch the Browser-based Performance Analyzer tool.

• Identify where Cachelink is installed on this computer.
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• Find information on contacting Mangosoft Technical Support

• Enable and disable Mangosoft product announcement notifications.

• Enable (show) or disable (hide) the Cachelink icon in your system tray.

• Access the Mangosoft Web site.
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The Configuration Utility Web Browsers Tab
The Web Browsers tab (Figure 3-2) is the second tab from the left. You can use this tab to view 
information about the Web browsers on your computer that can be automatically configured to 
use Cachelink.

Figure 3-2: The Web Browsers Tab

The Web Browsers tab displays a list of all the browsers on your computer that can be 
automatically configured to use Cachelink. Since Cachelink can only detect those browsers that 
are fully installed and set up to access the Internet, only those browsers are listed. This tab 
allows you to select which browsers on your computer should use Cachelink. You can select 
one or more of the browsers currently installed on your computer, or deselect them. You can 
also set Cachelink to check whether your browsers are using it each time you log on.

N O T E

Mangosoft recommends that you, at a minimum, configure your 
default Web browser to use Cachelink.

Each Netscape profile is listed as a separate browser. Netscape items list the Netscape version, 
language, and profile, enabling you to discern which you want to designate to use Cachelink. 
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The Configuration Utility Cache Tab
The Cache tab (Figure 3-3) is the third tab from the left. Your Cachelink cache is where the Web 
trinkets you have accessed from the Internet are stored. You can use this tab to view and modify 
information about this computer’s contribution to the LAN-wide Cachelink cache pool.

Figure 3-3: The Cache Tab

The Cache tab allows you to:

• View the folder where your cached Web trinkets are currently stored, and change this cache 
location if necessary.

• Designate the maximum amount of disk space you want allocated to your cache, either as 
a percentage of your hard drive, or as a number of Megabytes.

• Delete the cache, purging its current contents.
3-6 Cachelink User’s Guide 



The Cachelink Configuration Utility
The Configuration Utility Advanced Tab
The Advanced tab (Figure 3-4) is the right-most tab. You can view, and if necessary, modify 
proxy and port information on this tab. 

N O T E

You should not modify the information on this tab unless 
recommended by a system administrator or a Mangosoft 
Technical Support Engineer.

Figure 3-4: The Advanced Tab

The Advanced tab allows you to:

• Modify Cachelink communication ports.

• Set up Cachelink to access the Internet using Proxy Automatic Configuration.

• Set up Cachelink to access the Internet using a proxy server.
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Configuring Your Browsers to Use Cachelink
Cachelink works with a variety of Web browsers on the system where it is installed. During 
installation, the setup program can automatically configure the most popular browsers to use 
Cachelink. If you install a popular browser after installing Cachelink, you can cause Cachelink 
to automatically configure it by simply restarting your system.

You can use Cachelink with nonstandard browsers, but you will need to manually configure 
them as you would to have them use a proxy server. More information on manually configuring 
browsers appears in the following sections.

N O T E

The following procedures only apply to configuring browsers 
on the Cachelink Pro and Cachelink Connector Systems to use 
Cachelink. If you want to configure browsers on Connector 
Client systems, see the section titled ‘‘Configuring Connector 
Clients” in Appendix C.

Automatically Configuring Browsers
During installation, you can choose which popular browsers installed on your computer sh
be automatically configured to use Cachelink. Cachelink is able to automatically configur
Microsoft Internet Explorer version 4, 5, and 6, and Netscape Navigator version 4, 4.5, 4.6
and 6.0. 

Modifying Which Browsers Use Cachelink
Cachelink can work with one or more browsers currently installed and configured on you
computer. When you install Cachelink, the setup program prompts you to indicate which o
installed browsers you want configured to use Cachelink. Cachelink then takes the browse
have indicated, and begins continuously caching browsed trinkets whenever you access
Web with those browsers. 

Once Cachelink is running, you can modify the browsers it uses on your computer by doin
following:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Web Browsers tab (Figure 3-2).

3. The Web Browsers tab lists the browsers currently installed on your computer that h
been (or can be) automatically configured to use Cachelink. 
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If you are using Netscape with multiple profiles, you will see each Netscape profile listed 
separately so you can select or deselect one or more of them (the profile is shown in 
parentheses at the end of each Netscape item listed). 

Clicking in a check box next to a browser allows you to place or remove a check mark in 
the box. A checked box indicates Cachelink will use this browser. If you click the check 
box and clear the check mark in it, this disables Cachelink use with this browser. 

4. When you are satisfied with your browser settings, click OK on the Cachelink 
Configuration Utility.

If the browser you want to configure for Cachelink use does not appear in the Web Browsers 
tab, then you must configure the browser manually for use with Cachelink.

Manually Configuring Browsers
During installation, the setup program can automatically configure many popular browsers to 
use Cachelink. Browsers you can manually configure include Microsoft Internet Explorer 
version 4, 5, and 6, and Netscape Navigator version 4, 4.5, 4.6, 4.7, and 6.0. 

If you are using a different browser, you will need to configure it to use Cachelink manually. 
When you manually configure a browser to use Cachelink, you do so by setting Cachelink as 
that browser’s proxy server. You can also use this manual configuration process in the rar
that Cachelink cannot automatically configure one of the supported browsers listed abov

To manually configure a browser to use Cachelink:

1. Go to the screen or tab on your browser that allows you to modify connections or LA
settings. This is often accessible from your browser’s Options dialog box.

2. Click the check box that enables this browser to use a proxy server.

3. When you enter HTTP information for Cachelink as a proxy server:

• Specify 127.0.0.1 as the address.

• Specify the Local HTTP Port (shown in Figure 3-4). The default port number is 8080.

4. Click OK on the dialogs you have navigated through to activate your settings.
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Displaying or Hiding the Cachelink Tray Icon
Cachelink allows you to choose whether or not the Cachelink tray icon appears in your system 
tray, at the lower right corner of your computer screen.

To change the setting for the Cachelink tray icon in your computer’s system tray:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the General tab (Figure 3-1).

3. Click the Enable Cachelink Icon in System Tray check box to change its setting.

• If you want to hide the icon, ensure the check box is cleared (deselected). 

• If you want the icon to display, ensure the check box is checked (selected).

4. Click OK.
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Managing Your Cachelink Cache
The installation wizard for Cachelink provides a default cache location and size that are 
sufficient for a majority of installations. If you wish, you may modify these settings using the 
Custom setting on the installation wizard. In addition, Cachelink allows you to modify these 
settings at any time after installation.

N O T E

If you are viewing the Cachelink Activity Meter when you 
move, purge, or reduce the size of the Cachelink cache, the 
meter will automatically close. Note that the Activity Meter is 
only available on the retail version of Cachelink Pro.

Changing the Cache Location
You can change the location of the cache where Cachelink stores trinkets (Web items) for access 
by other Cachelink systems. You may want to change your cache location if you want Cachelink 
to store its information on another drive, or in another directory. Note that when you change 
your cache location, Cachelink simply deletes the old cache and creates an empty cache in the 
new directory and fills it with new information as you browse the Internet.

To change the folder where Cachelink stores Web data:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Cache tab (Figure 3-3). You can view the current folder where the cache is 
located at the top of the tab.

3. Click Change.

4. Browse to the folder where you wish to cache information, and click OK. The new folder 
will appear in the Cache tab.

5. Click OK on the Cachelink Configuration Utility.

6. If a wait cursor (usually an hourglass) appears, ensure the wait cursor returns to its normal 
style (usually an arrow), signifying your change has taken affect. You should allow the 
process to complete before performing any other system actions.

Changing the Cache Size
You can change the size of the cache where Cachelink stores Web information. Mangosoft 
recommends a minimum cache size of 30 MB for Cachelink Pro, and 100 MB for Cachelink 
Connector. By default, during installation the maximum cache size is set at 3% of the total disk 
space on the installation drive.

To change the size of your cache:
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1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Cache tab (Figure 3-3).

3. You can either click the slider which indicates the percentage of your drive to use for the 
cache and pull it to the desired percentage, or you can enter the number (either by typing it, 
or using the up/down arrows) of MB (Megabytes) you want to provide as a maximum size 
for the cache.

4. When you are finished, click OK.

5. If a wait cursor (usually an hourglass) appears, ensure the wait cursor returns to its normal 
style (usually an arrow), signifying your change has taken affect. You should allow the 
process to complete before performing any other system actions.

If you reduce the size of your cache, the cache is deleted and a new cache is created with a 
maximum limit of the size specified. If you increase the size of your cache, the cache is 
permitted to grow until it reaches the new size, and then older information is removed from the 
cache as needed to permit newly browsed items to be stored.

Purging Your Cache
You never have to delete your cache, because Cachelink optimizes the storage of Web trinkets. 
Cachelink automatically removes older items from the cache, ensuring that newly-accessed 
Web material is always cached. 

At some point, you may want to delete your cache to quickly free up some disk space on your 
computer. Note that deleting your cache does not affect your Internet access, though you may 
notice Web pages that loaded quickly with your cached information will load more slowly as 
the information is again accessed from the Internet.

To delete your cache:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Cache tab (Figure 3-3).

3. Click the Delete Cache button. The information in your cache is deleted immediately.

4. If a wait cursor (usually an hourglass) appears, ensure the wait cursor returns to its normal 
style (usually an arrow), signifying your change has taken affect. You should allow the 
process to complete before performing any other system actions.
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Changing Your License
Cachelink can be used with two types of licenses:

• Trial - A trial license is temporary. If you install Cachelink on a computer and do not enter 
a specific license ID, the installation will use a trial license.

• Permanent - A permanent license is purchased outright, and does not expire.

Unless using a trial license, all users require a unique license to run Cachelink. When a trial 
license expires, you must obtain a permanent license for further Cachelink use. You can 
purchase licenses from Mangosoft’s Web site (www.mangosoft.com), or from a Mangosoft 
Reseller.

When a trial license expires on a Cachelink Pro system, the system displays a message 
indicating that you must upgrade to a permanent license.

When a trial license expires on a Cachelink Connector system, the system displays a message 
indicating that you must upgrade to a permanent license. In addition, until a permanent license 
is entered, the system will operate as though it were running Cachelink Pro. That is to say, the 
Connector System will continue to allow its own system users to browse the Internet and obtain 
Cachelink’s benefits, but the Connector Clients that look to that Connector System for Int
access will display an Access Denied message and state that the Connector System is 
experiencing a license violation.

To convert from a trial license to a permanent license, you will need to modify the license
Cachelink uses on your computer.

To change your license ID:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the General tab (Figure 3-1).

3. Click the Change ID button. The Enter License ID dialog box appears.

4. You are prompted to enter your 10-character license. If you do not have a license ava
click the Get License ID button to be connected automatically to the page on the Mang
Web site where you can purchase Cachelink licenses. Once you have obtained a lic
enter it in the License ID field.

5. When you have finished entering the unique license ID, click OK. Your new license sh
now appear as the license listed on the General tab.
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Advanced Settings
The following sections list advanced settings that users will not usually need to change, 
including setting specific ports, setting Cachelink to use proxy automatic configuration, and 
setting Cachelink to use a proxy server.

About Cachelink Ports
Cachelink is designed to use specific ports for inter-cache and inter-computer communications. 
These ports allow one computer running Cachelink to locate previously cached information on 
other computers, and then obtain that information locally for display. In a vast majority of cases, 
the default settings for these ports work properly, and you will not have any problems using 
Cachelink.

There are two types of ports Cachelink uses:

• The HTTP ports are the TCP/IP network ports Cachelink listens to for HTTP (Hyper-Text 
Transfer Protocol) requests from the local computer’s browser. The Local HTTP port is for 
requests from the local browser, and the Remote HTTP port is for requests from other 
Cachelink nodes. 

• The HTCLP port is the port that Cachelink uses to communicate with other Cachelink 
processes that are running on other computers on your network to locate cached 
information. HTCLP stands for the Hyper-Text Cachelink Protocol, a Mangosoft-specific 
protocol used to communicate between Cachelink computers. This inter-computer 
communication enables Cachelink to find cached information for display on your 
computer.

Occasionally, a computer running Cachelink will have a port conflict because the ports that 
Cachelink uses by default are already in use by another piece of software. The symptoms of this 
type of problem include receiving installation error messages that indicate you have 
encountered error 8, 9, or 11. If you receive one of these error messages, go to the Mangosoft 
support page, at www.mangosoft.com/support, for additional information.

The default settings for the HTTP and HTCLP Cachelink ports are as follows:

• The default setting for the local HTTP port is 8080.

• The default setting for the remote HTTP port is 8081.

• The default setting for the HTCLP port is 7006. 

Should you find you have a port conflict with these specific port numbers, use the following 
instructions to modify the setting for the port in question.
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Specifying HTTP Local and Remote Ports
For a vast majority of installations, you should not need to modify the HTTP Port information 
for Cachelink.

If your computer system is running another application that uses either of the default HTTP port 
numbers (8080 or 8081), you may want to change the port number on Cachelink or the other 
application to ensure proper operation. If two applications are using the same port number, you 
may see unusual behavior in the application that started later as it attempts to access a port 
already in use.

C A U T I O N

If you do choose to modify the HTTP local and remote ports for 
Cachelink, ensure you choose unique port numbers that are not 
already in use by any other program. Coordinate to make sure 
all Cachelink users on the LAN are set to the same port 
numbers. If you change the HTTP remote port, it is vital that 
you ensure all Cachelink Connector Clients are using this 
remote port in their proxy server settings. Cachelink only 
connects the caches of those computers with the same HTTP 
port numbers, and so can only provide benefits to those with the 
same port numbers.

To specify an HTTP port for Cachelink to use:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Advanced tab (Figure 3-4).

3. Enter the new port number(s) in the HTTP Port field(s).

4. Click OK.
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Specifying an HTCLP Port
For a vast majority of installations, you should not need to modify the HTCLP Port for 
Cachelink.

If your computer system is running another application that also uses the default HTCLP port 
number (7006), you may want to change the port number on Cachelink or the other application 
to ensure proper operation. If two applications are using the same port number, you may see 
unusual behavior in the application that started later as it attempts to access a port already in use.

C A U T I O N

If you do choose to modify the HTCLP port for Cachelink, 
ensure you choose a unique port number that is not already in 
use by any other program. Coordinate to make sure all 
Cachelink users on the LAN set the HTCLP port to the same 
port number. Cachelink only connects the caches of those 
computers using the same HTCLP port number.

To specify an HTCLP port for Cachelink use:

1. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

2. Click the Advanced tab (Figure 3-4).

3. Enter the new port number in the HTCLP Port field.

4. Click OK.
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Using Cachelink with Proxy Automatic Configuration
Cachelink supports environments that use Proxy Automatic Configuration. If you are using one 
of the browsers that Cachelink can configure automatically, you can specify that your browser 
use configuration information contained in a file provided by your Network Administrator.

If your browser is already configured to use proxy automatic configuration, Cachelink obtains 
this information from your browser and automatically checks the Use proxy automatic 
configuration script check box and fills in the Address field with the script file’s path locat

If you need to configure proxy automatic configuration information after installing Cachel
you must manually enter a check mark in the checkbox and fill in the Address field.

If you are uncertain whether you need to specify the use of proxy automatic configuration
your Network Administrator.

To set up Cachelink to work with proxy automatic configuration:

1. Go to your Network Administrator to find out the name and location of the proxy autom
configuration script file.

2. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

3. Click the Advanced tab (Figure 3-4).

4. Click the Use proxy automatic configuration script check box, then enter the Addres
information in the Address text box.

5. Click OK.
Customizing Cachelink 3-17



Advanced Settings

ttings 
er, 

ork 

ort 
Using Cachelink with a Proxy Server
Cachelink supports environments that use proxy servers. If you are using one of the browsers 
that Cachelink can configure automatically, Cachelink can capture that browser’s proxy se
during installation. If you need to manually configure Cachelink to work with a proxy serv
follow the procedure below.

If you are uncertain whether your browser access requires a proxy server, ask your netw
administrator if you will need to use Cachelink with a proxy server.

To set up Cachelink to work with a proxy server:

1. Go to your Network Administrator to find out the proxy server’s HTTP address and p
number you will need to provide to Cachelink.

2. Launch the Cachelink Configuration Utility (as described in the first section of this 
chapter).

3. Click the Advanced tab (Figure 3-4).

4. Click the Access the Internet Using a Proxy Server check box.

5. Enter the appropriate address information in the HTTP field.

6. Enter the appropriate port number in the Port field.

7. Click OK.
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Appendix A
Installing Cachelink Pro from a KitA-

Cachelink® Pro uses a very simple installation program. This wizard-based installation program 
allows users to quickly and easily install Cachelink Pro on Windows-based computer systems.

There are two ways to install Cachelink Pro:

• By launching the self-extracting executable program (kit). This installation is ideal for 
a majority of users. With this method, an easy-to-use wizard walks you quickly through the 
installation process. Installations typically take less than 2 minutes.

• By creating a network installation for the software. If you are interested in installing 
Cachelink Pro from a centralized network share onto many computer systems at a single 
site, you can prepare Cachelink Pro for network installation by following the instructions 
in Appendix B.

The installation program automatically configures commonly-used browsers to use Cachelink 
Pro if it finds them installed and ready to access the Internet. 

The installation program can automatically configure the following browsers to use Cachelink 
Pro:

• Internet Explorer versions 4, 5, and 6

• Netscape versions 4.0, 4.5, 4.6, 4.7, and 6.0

Other browsers can be configured to use Cachelink Pro the same way they are configured to use 
a proxy server for HTTP, by setting the browser’s HTTP proxy to point to the address 127.
and the port 8080. If you need to manually configure a browser to user Cachelink Pro, se
section titled ‘‘Manually Configuring Browsers” in Chapter 3.

Note that during installation, to optimize your system, Cachelink Pro also configures you
browsers to use HTTP 1.1.

This appendix contains the following sections:

• ‘‘Preparing for Installation”

• ‘‘Installing Cachelink Pro”

• ‘‘Getting Started with Cachelink Pro”
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Preparing for Installation
To run Cachelink Pro, a computer must satisfy the following requirements: 

• Windows 95, Windows 98, Windows NT 4, Windows 2000, or Windows ME operating 
system.

• Pentium-compatible processor, 200 MHz or faster.

• 32 MB of memory (RAM).

• 5MB of free disk space, plus 30 MB additional space to be used as part of the Cachelink 
cache.

• Microsoft’s TCP/IP installed and properly configured.

• Network Interface Card (NIC) installed and properly configured for Internet access.

• Web Browser installed and properly configured to access the Internet via your LAN. Each 
resident browser that will use Cachelink must be configured to access the Internet through 
the computer’s LAN connection. Cachelink is not designed for use in environments w
each computer accesses the Internet through its own modem.

Ensure your computer meets the above requirements to ensure a smooth and successfu
installation. 
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Installing Cachelink Pro
To install Cachelink Pro on your computer:

1. Make sure the Cachelink Pro installation program is available from one of your compute
drives or a network share. You can download the software kit from the Mangosoft Web
(www.mangosoft.com). Cachelink licenses can be purchased on the Web site, or fro
Mangosoft Reseller.

2. Launch the self-extracting Cachelink Pro installation program. You can use Window
Explorer to navigate to the directory containing the Cachelink Pro installation program
and double-click the file to launch it.

3. The Welcome screen displays. This is the first screen in the Cachelink installation wi
To proceed with your installation, click Next.

4. The Readme screen displays. Click the View Readme button to view information ab
Cachelink and any late-breaking installation issues. You can view the readme online
print it for later reference. Click Next to proceed with the Cachelink Pro installation.

5. The End User License Agreement (EULA) screen displays. Use the scroll bar at the
of the EULA to scroll down. When you have finished reading the EULA, select the 
appropriate radio button beneath.

• If you select the option indicating you accept the agreement, you can continue with the 
installation by clicking Next.

• If you select the option indicating you do not accept the agreement, you cannot proceed 
with the installation. You must click Cancel to exit the installation at this time. If you 
have concerns about the EULA, contact Mangosoft or your Mangosoft Reseller for 
clarification.

6. The Cachelink Requirements screen displays. Carefully read the installation requirements 
on this screen to ensure your computer meets them. If your computer does not meet these 
requirements, your installation will fail.

• If your computer already meets these requirements, click Yes, and then click Next.

• If your computer does not meet all of the listed requirements, you should click No, and 
Cancel the installation at this time. 

• If you are unsure whether your computer meets these requirements, contact your 
system administrator for assistance. 

Once your computer does meet the listed requirements, you can restart the installation as 
described above, proceed through the installation to this point, then click Next.

7. The License ID screen displays. By default, the license TRYANDBUY! appears. This 
license is used to install Cachelink Pro for a free trial.

• If you have acquired a Cachelink Pro permanent license, enter its license ID now. If 
you have been instructed to install this software on your computer, but have not been 
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provided with a license, contact your system administrator to obtain a valid license ID. 
Once you have entered your unique license ID, click Next.

• If you are installing Cachelink Pro on a trial basis, leave the license ID as it appears 
and click Next.

8. The Installation Type and Location screen displays. 

First, you must choose where Cachelink Pro will be installed on your computer. The default 
location is C:\Program Files\Mango\Cachelink. To change this location, click the Change 
button, browse to the desired location, and click OK.

Then, you must choose whether you want to use the typical settings for this installation. By 
default, the typical settings ensure that Cachelink Pro configures all installed Web browsers 
it is capable of configuring, and specifies a cache size that is 3% of the free space on the 
drive where you wish to install Cachelink Pro.

• If you want to accept all typical settings for the installation, leave the Typical radio 
button selected, and click Next. Then skip to step 11 below to continue with your 
installation.

• If you want to choose custom installation settings, click the Custom radio button, and 
click Next.

9. If you chose a Custom installation, the Web Browsers screen displays. This screen lists all 
of the installed browsers on this computer that can be automatically configured to use 
Cachelink Pro (Netscape 4.0, 4.5, 4.6, 4.7, and 6.0, and Internet Explorer 4, 5, and 6). 
Allowing all of your browsers to use Cachelink Pro ensures that all of the Web content you 
access is cached for use by other Cachelink users, regardless of the browser you are using. 
Ensure the browsers you want configured to use Cachelink are selected (checked), and click 
Next.

N O T E

Mangosoft recommends that you configure at least your default 
browser to use Cachelink Pro.

10. If you chose a Custom installation, the Cache Location and Size screen displays. 

The Cache Location defaults to C:\Program Files\Mango\Cachelink\WebCache. If you 
want to choose a different location, click the Change button, browse to the desired location, 
and click OK.

The Cache Size defaults to 3% of the total disk space available on the cache drive you 
specify. You can increase or decrease the cache size. For best results, Mangosoft 
recommends you specify a cache size of 30 MB or more for Cachelink Pro.

When you have finished setting the cache location and size, click Next.
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11. The Summary screen displays, enabling you to verify the settings you chose for your 
Cachelink Pro installation.

• If you are satisfied with the settings, click Finish to complete the installation.

• If you want to modify one or more settings, click the Back button, modify the desired 
settings, and return to this screen. Then click Finish.

12. The Cachelink Pro files are quickly copied and installed to the target directory on your 
computer. A success message displays when the installation is complete.

N O T E

If you received an error message, or your installation fails, 
ensure you met the requirements outlined at the start of this 
chapter. Once you are sure you meet these requirements, start 
the installation procedure again. If problems persist, check the 
readme.txt file which you can view during installation. If you 
cannot resolve your problems, contact Mangosoft Technical 
Support for assistance as described in the Preface of this guide.

Getting Started with Cachelink Pro
There is no need to start Cachelink. Cachelink starts automatically after installation and runs in 
the background, quietly saving you time and money.

For information on the Cachelink user interface, see Chapter 1.

For information on monitoring Cachelink activity, see Chapter 2.

For information on modifying Cachelink settings, see Chapter 3.
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Appendix B
Cachelink Pro Network Installation and

License ManagementB-

There are two ways to install Cachelink Pro:

• By launching the self-extracting executable program. This installation is ideal for a 
majority of users. This kit-based installation is described in Appendix A.

• By creating a network installation for the software. Installing Cachelink from a 
centralized network share onto many computer systems as described in this appendix.

Cachelink Network Installation is a process for installing Cachelink Pro from a network share 
that provides centralized management of Cachelink licenses and ensures consistency in 
Cachelink settings during installation.

N O T E S

1. When you follow the procedure below to set up network 
installation, you are not actually installing Cachelink Pro. 
You are creating a network install kit from which other 
computers can install Cachelink Pro.

2. Note that when you perform a Cachelink Pro upgrade or 
reinstallation, even via network install, the installation 
program does not modify any of your Cachelink or 
Cachelink-related system settings. 

This appendix contains the following sections:

• ‘‘Before You Start”

• ‘‘Preparing for Network Installation”

• ‘‘Testing Your Network Installation”

• ‘‘Installing Cachelink Pro on Each Windows Computer”

• ‘‘Troubleshooting”

• ‘‘Managing Cachelink License Keys with Network Installation”

• ‘‘Adding New License Keys to the Available Directory”

• ‘‘Recovering License Keys That Are No Longer in Use”
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Before You Start
Before preparing your network install, verify that you have the following items:

• The Cachelink Pro installation kit.

• A file or e-mail message containing Cachelink Pro licenses for each of your Windows 
computers.
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Preparing for Network Installation
In order to make the Cachelink Pro kit network installable, do the following:

1. Identify a shared network drive that you will use to hold the Cachelink Pro kit for network 
installations. Create or choose a directory from which people will perform their network 
installation of Cachelink Pro. Consult Microsoft’s documentation if you need instructions 
on creating a network share.

2. Launch the self-extracting Cachelink Pro installation program. Use Windows Explorer to 
navigate to the directory containing the Cachelink Pro self-extracting executable file and 
double-click the file to launch it.

3. The Welcome screen of the installation wizard displays. To proceed with your installation, 
click Next.

4. The Readme screen displays. Click the View Readme button to view information about 
Cachelink Pro and any late-breaking information about installation issues. 

5. The End User License Agreement (EULA) screen displays. When you have finished 
reading the EULA, select the appropriate radio button beneath. 

• If you select the option indicating you accept the agreement, you can continue with the 
installation by clicking Next.

• If you select the option indicating you do not accept the agreement, you cannot proceed 
with the installation, and must click Cancel to exit the installation at this time. If you 
have concerns about the EULA, contact Mangosoft or your Mangosoft Reseller for 
clarification.

6. The Cachelink Requirements screen displays. Carefully read the requirements on this 
screen, as you will want to ensure the computers at your site that will use the Cachelink Pro 
network install meet these requirements. Note that if the computer on which you are 
running the install wizard does not meet these requirements, you can still proceed to 
successfully complete the setup of a network install. Click Next to continue.

7. The License ID screen displays. By default, the free trial license TRYANDBUY! appears. 
Replace the text in the license field with the single word NETINSTALL.

8. The Network Folders and License List screen displays.

• In the Network Share for Cachelink Program Files field, enter the network share you 
created in Step 1, in the form \\computer\directory.

• In the License ID List area, replace the text in that area with your Cachelink Pro 
licenses.

• If you wish, you can click Advanced. Filling in the Advanced Settings dialog is 
OPTIONAL. If you DO NOT enter any information in the Advanced Settings dialog, 
by default the setup wizard will create a Licenses directory under the network share 
where your licenses will be stored and managed, and a Tracefiles directory under the 
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network share, where installation log files will be stored for the computers that use the 
network install. Click OK to return to the Network Folders and License List screen.

N O T E

Mangosoft recommends that you accept the setup defaults and 
do not modify the default locations for the Licenses and 
Tracefiles directories.

9. When you have finished entering the requested information in the License ID Folder and 
List screen, click Next. If a message box displays asking whether you want to create the 
directories you specified, click Yes.

N O T E

The remaining steps involving the network install wizard 
collect settings that will be applied to each computer that 
executes a network installation.

10. The Installation Type and Location screen displays. First, you must choose whether you 
want to use the typical settings for this installation. By default, the typical settings install 
Cachelink in the Program Files directory on the drive where Windows is installed, ensure 
that Cachelink Pro configures all installed Web browsers it is capable of configuring to use 
Cachelink, and specifies a cache size that is 3% of the total disk space on the drive where 
Cachelink Pro is installed.

• If you wish to accept the typical settings for the installation type and location, leave the 
Typical radio button selected. 

• If you want to choose custom installation settings, click the Custom radio button.

11. Next, you must choose where Cachelink Pro will be installed on your computers. The 
default location is %Program Files%\Mango\Cachelink. To change this, enter the 
appropriate value in the field. Because different computers have different mapped drive 
letters and drive sizes, you can use a macro value for the target directory if you wish:

• %MostFreeDrive% is the fixed drive with the most free space.

• %BiggestDrive% is the fixed drive with the largest capacity.

• %WindowsDrive% is the drive on which Windows is installed.

• %ProgramFiles% expands to %WindowsDrive%\Program Files.

So to specify that you want Cachelink Pro installed on the user’s fixed drive with the most 
free space, you could enter:

%MostFreeDrive%\Cachelink

12. When you have finished with the Installation Type and Location screen, click Next. 
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• If you have chosen a Typical Installation, skip to step 16 below to continue with your 
installation.

• If you have chosen a Custom Installation, proceed with the next step.

13. If you chose a Custom installation, the Proxy Server screen displays. This screen allows 
you to select whether people at your site use a proxy server and/or a proxy automatic 
configuration script to connect to the Internet. Select the appropriate option for your facility 
and click Next.

14. If you chose a Custom installation, the Cache Location and Size screen displays. The 
default cache location is %Program Files%\Mango\Cachelink\WebCache. If you want to 
choose a different location, you can select a macro as you did for the installation directory. 
The options include:

• %MostFreeDrive% the fixed drive with the most free space.

• %BiggestDrive% the fixed drive with the largest capacity.

• %WindowsDrive% the drive on which Windows is installed.

• %ProgramFiles% expands to %WindowsDrive%\Program Files.

So to specify that you want the Cachelink Pro cache located on the computer’s fixed drive 
with the most free space, you could enter:

%MostFreeDrive%\CachelinkCache

15. The Cache Size defaults to 3% of the total disk space available on the cache drive. You can 
increase or decrease the cache size. For best results, Mangosoft recommends you specify a 
cache size of 30 MB or more for Cachelink Pro. 

When you have finished setting the cache location and size, click Next.

16. A summary screen displays the information that will be used for all computers using the 
network install. If you are satisfied with your settings, click Finish. If not, click Back, 
modify the settings as needed, return to this screen, and then click Finish.

17. The Cachelink Pro files are quickly copied and installed to the network share. A success 
message displays when the network install preparation is completed.

18. At this time, you may want to modify security permissions on the network install 
directories. For security purposes, Mangosoft recommends you ensure that the directory 
where the network install kit resides is writable by you, but read-only by end-users. In 
addition, you should ensure that the Licenses directory is read/write for all users, as is the 
Tracefiles directory. 
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Testing Your Network Installation
It is important that you test your network installation before you inform your users that they 
should install Cachelink Pro from the network share. This testing helps ensure that you have the 
Cachelink Pro kit, network shares, and licenses properly set up for your network environment.

Test the network installation you created by going to one or more computers on the network and 
ensuring you can successfully install Cachelink Pro from the Cachelink setup program located 
in the network share.

When you have finished your testing, go to the Tracefiles directory (under the network share) 
and view the installation logs from your test installations. Log files for computers that 
successfully completed the network installation are named success_computername.log. Logs 
for computers that encountered problems are named error_computername.log.

If you encountered problems, you should isolate and resolve them before proceeding with your 
invitation to users to perform a network install of Cachelink Pro.
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Installing Cachelink Pro on Each Windows Computer
To install Cachelink Pro on each Windows computer, execute the Cachelink setup program on 
each computer from the network share. One way to do this is to send users an e-mail with a 
pointer or link to the Cachelink Setup program so that they can each perform the installation 
themselves. Or, you can go to the systems yourself, installing individually on each one.

When you run the Cachelink setup program, Cachelink Pro will be installed according to the 
settings you provided when you ran the network install wizard. 

Using network install, the Cachelink setup program will generally require only one click to 
dismiss the dialog that indicates that Cachelink was successfully installed.

N O T E

Due to security constraints on Windows NT and Windows 2000 
computers, you must be logged on to an account with 
administrator privileges to run the Cachelink Setup program.
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Getting Started with Cachelink Pro
Once you have installed Cachelink Pro, there is no need to start the software. Cachelink Pro 
starts automatically after installation and runs in the background, quietly saving you time and 
money.

For information on the Cachelink user interface, see Chapter 1.

For information on monitoring Cachelink activity, see Chapter 2.

For information on modifying Cachelink settings, see Chapter 3.
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Troubleshooting
If an error occurs when running Cachelink’s setup program during a network installation, an 
informative error message will appear. The most likely causes of errors are:

• The end-user computer’s network settings are incorrect.

• There was a problem with the setup wizard.

• There was a problem with the network shares.

• The end-user is installing on a Windows NT or Windows 2000 system, but is not logged on 
to an account with administrator privileges.

If network settings are incorrect on the end-user’s computer, go to the Mangosoft support Web 
page (www.mangosoft.com/support) for information regarding network configuration error 
messages. Then correct the problem and try again.

If there was a problem with your network shares, the error message should be sufficiently 
informative to identify the problem. Also, confirm that you have proper access to the network 
shares (read-only or read/write to the net install network share and read/write to the Licenses 
and Tracefiles directories).

A Tracefiles directory was created when you set up the network install. It is located, by default, 
under the network share, and allows you to locate systems where installation problems have 
occurred. The Tracefiles directory provides you with a central location where you can view the 
log of each network install performed. Log files are named success_computername.log or 
error_computername.log, depending on whether the installation was successful or not.
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Managing Cachelink License Keys with Network Installation
Cachelink’s Network Installation includes a basic approach to managing and tracking Cachelink 
Pro license IDs that are in use at your site.

Here is how Cachelink Pro license management works:

1. When you set up a network install, the license IDs you enter into the setup wizard are placed 
in a directory called Available that is created under the Licenses directory. By default, the 
Licenses directory is placed under the installation network share.

2. When a user installs Cachelink on a computer, that computer acquires a Cachelink license 
ID from the Available subdirectory.

3. Once the license key has been acquired, it is automatically removed from the Available 
subdirectory, because it is now in use. The license management portion of the Cachelink 
Pro software moves the license ID file out of the Available subdirectory, and up to the 
Licenses directory. It then renames the file to include the name of the computer that 
acquired the license ID, followed by the license ID itself, so you will know which computer 
is using that particular license.
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Adding New License Keys to the Available Directory
When you purchase additional Cachelink licenses, they can be made available for use via 
Cachelink network installation as described below. You can add licenses at any time.

To process your Cachelink licenses and make them available for network installation, simply 
run the Cachelink Pro installation wizard as described earlier, and enter the license keys where 
prompted. To ensure consistent installation and configuration across all systems, enter the exact 
same information as before for all other wizard screens, with the addition of the new licenses.

You can check to see which licenses are available by looking in the Available subdirectory of 
the Licenses directory.
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Recovering License Keys That Are No Longer in Use
If a computer user on a computer running Cachelink decides to remove Cachelink from that 
computer, the uninstall program attempts to reclaim the license. 

When a license is reclaimed, the name of the license file in the Licenses directory reverts so that 
it no longer contains the name of the computer on which it was installed, leaving only the license 
ID as the license file name. At that point, the license file is returned to the Available 
subdirectory of the Licenses directory, where it can be automatically used for a network 
installation on another system.

To locate and recover Cachelink licenses that are no longer in use, and for some reason could 
not be recovered:

1. Go to the Licenses directory and print out a directory of the files (used licenses) it contains.

2. Launch the Cachelink Performance Analyzer on a computer on this LAN that is running 
Cachelink Pro. Go to the computer, choose Start > Programs > Cachelink > Configuration, 
and click Performance Analyzer.

3. Read through the list of licenses in use that you printed and compare it to the list of 
computers that are currently running Cachelink (shown on the left-hand side of the 
Performance Analyzer). Cross out all licenses on the printed list that are currently running 
Cachelink.

4. If you are running Cachelink Pro on multiple local area networks (LANs) at your site, and 
have installed the Cachelink software on all the LANs from the same network share, you 
will need to go to one Cachelink computer on each LAN, and repeat steps 2-3 on each LAN. 
The Performance Analyzer can only display Cachelink information about a particular 
LAN. Cross out the names on the printed list that are displayed by the Performance 
Analyzer view on each LAN.

5. When you have finished comparing the list to the Performance Analyzer list on every 
Cachelink LAN, circle the names of computers that you have not crossed out. These are the 
computers that are not currently running Cachelink, usually because they are turned off, but 
possibly because Cachelink could not reclaim the license when the software was 
uninstalled, or because the computer is no longer in use.

6. Contact the owners of those computer systems to find out whether the systems are still in 
use. If not, you should reclaim their license. If so, check to see if they are still running 
Cachelink. If they are no longer running Cachelink, you can reclaim their license.

7. Once you have a list of licenses you can reclaim, go to the Licenses directory.

8. Locate a license file that contains the name of one of the computers whose license you need 
to reclaim.

9. Rename the license file in the Licenses directory so that it no longer contains the computer 
name or underscore, and leave only the 10-character license ID as the file name.

10. Locate and rename all other license files in the License Share that you wish to reclaim. 
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11. When you are finished renaming the reclaimed licenses, move the renamed license files to 
the Available subdirectory of the Licenses directory, making them available for use.
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Appendix C
Cachelink Connector Overview, Installation,

and ConfigurationC-

This appendix provides an overview of Cachelink® Connector and describes how to install the 
Cachelink Connector software, and configure Connector Clients so they can benefit from 
Cachelink.

Cachelink Connector uses a wizard-based installation program to install Cachelink on Windows 
computer systems. You install Cachelink Connector by launching the self-extracting executable 
program. An easy-to-use wizard walks you through the installation process. 

After installing the software on the Connector System, you must go to each of the non-Windows 
systems that you want to configure as Connector Clients, and set them up to use the Connector 
System as their browser’s proxy server. This allows them to take advantage of the Conn
System’s cache storage and sharing ability.

This chapter contains the following sections:

• ‘‘Cachelink Connector Overview”

• ‘‘Preparing for Installation”

• ‘‘Installing Cachelink Connector”

• ‘‘Configuring Connector Clients”
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Cachelink Connector Overview
When using Cachelink Connector, the Connector software is installed on a Windows-based 
computer, called the Connector System. A number of non-Windows computers are then 
configured to point to the Connector System as their proxy server. These systems are called 
Connector Clients. 

When a non-Windows computer that is a Connector Client browses a Web page, the Web items 
(the sounds, graphics, text, animations, and scripts that are referred to as trinkets) on that page 
are stored in the Connector System’s Web cache. If another Cachelink computer browses
same Web page, the trinkets are retrieved from the Connector System’s cache, rather tha
the Internet. Computers that can take advantage of cached Web information include 
Windows-based computers running Cachelink Pro or Cachelink Connector, or non-Wind
Connector Client computers. 

Depending on the power of the PC running the Cachelink Connector software, a single 
Connector System can handle the caching and cache-serving needs of 20 or more non-W
Connector Clients. The more computers that are either configured as Connector Clients,
running Cachelink Pro, the more Web trinkets are cached and made available to all user

Figure 3-1 shows a sample Cachelink network containing Windows-based PCs running 
Cachelink Pro, a Windows-based PC running Cachelink Connector, and non-Windows 
Cachelink Clients.

Figure 3-1: Sample Cachelink System Network
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Preparing for Installation
To run Cachelink, a computer must satisfy the following minimum requirements: 

• Windows 95, Windows 98, Windows NT 4, Windows 2000, or Windows ME operating 
system.

• Pentium-compatible processor, 500 MHz or faster.

• 128 MB of memory (RAM).

• 5MB of free disk space, plus 100 MB additional space to be used for the Cachelink cache.

• Microsoft’s TCP/IP installed and properly configured.

• Network Interface Card (NIC) installed and properly configured for Internet access.

• Microsoft’s Winsock 2.2 or greater (lower versions of Winsock do not support many 
multiple, simultaneous connections).

• Web Browser installed and properly configured to access the Internet via your LAN. Each 
resident browser that will use Cachelink must be configured to access the Internet through 
the computer’s LAN connection. Cachelink is not designed for use in environments w
each computer accesses the Internet through its own modem.

Cachelink Client systems are non-Windows computers that benefit from the Cachelink 
Connector software you have installed. The Connector Clients are configured to rely on 
Connector System as their proxy server. If you have many non-Windows computers that
will configure as Connector Clients, you may want to install Cachelink Connector on two
Windows systems, to distribute the load. If you are unsure how many Cachelink Connec
systems you require, contact Mangosoft or your Mangosoft Reseller.

N O T E

Because the Connector Client machines will rely on the 
Connector System for their access to the Internet, as well as 
their access to Cachelink savings, ensure the system you choose 
as your Connector System is fast enough to support this 
additional load. This system must remain up and available at all 
times to ensure connectivity and proper Cachelink operation. If 
your non-Windows system Web browsing is mission-critical to 
your work, you might consider dedicating a Windows system to 
work solely as a Cachelink Connector system.
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Installing Cachelink Connector
To install Cachelink Connector on a computer:

1. Make sure the Cachelink Connector installation program is available from one of your 
computer’s drives or a network share.

2. Launch the self-extracting Cachelink Connector installation program. You can use 
Windows Explorer to navigate to the directory containing the Cachelink Connector 
installation program file and double-click the file to launch it.

3. The Welcome screen displays. This is the first screen in the Cachelink Connector 
installation wizard. To proceed with your installation, click Next.

4. The Readme screen displays. Click the View Readme button to view information ab
Cachelink and any late-breaking information about installation issues. You can view 
readme online, or print it for later reference. Click Next to proceed with the Cachelink
Connector installation.

5. The End User License Agreement (EULA) screen displays. Use the scroll bar at the
of the EULA to scroll down. When you have finished reading the EULA, select the 
appropriate radio button beneath.

• If you select the option indicating you accept the agreement, you can continue with the 
installation by clicking Next.

• If you select the option indicating you do not accept the agreement, you cannot proceed 
with the installation. You must click Cancel to exit the installation at this time. If you 
have concerns about the EULA, contact Mangosoft or your Mangosoft Reseller for 
clarification.

6. The Cachelink Requirements screen displays. Carefully read the requirements on this 
screen to ensure your computer meets them. If your computer does not meet these 
requirements, your installation will fail.

• If your computer already meets these requirements, click Yes, and then click Next.

• If your computer does not meet all of the listed requirements, you should click No, and 
Cancel the installation at this time. If you are unsure whether your computer meets 
these requirements, contact your system administrator for assistance. Once your 
computer does meet the listed requirements, you can restart the installation as 
described above, proceed through the installation to this point, then click Next.

7. The License ID screen displays. By default, the trial license appears. This license is used to 
install Cachelink Connector for a free trial.

• If you have acquired a Cachelink Connector permanent license, enter it now. If you 
have been instructed to install this software on your computer, but have not been 
provided with a license, contact your system administrator to obtain a valid license ID. 
Once you have entered your unique license ID, click Next.

• If you are installing Cachelink Connector on a trial basis, leave the license ID as it is 
and click Next.
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8. The Installation Type and Location screen displays. 

First, you must choose where Cachelink Connector will be installed on this computer. The 
default location is C:\Program Files\Mango\Cachelink. To change this location, click the 
Change button, browse to the desired location, and click OK.

Then, you must choose whether you want to use the typical settings for this installation. By 
default, the typical settings ensure that Cachelink Connector configures all installed Web 
browsers it is capable of configuring, and specifies a cache size that is 3% of the free space 
on the drive where you choose to install Cachelink Connector.

• If you wish to accept all typical settings for the installation, leave the Typical radio 
button selected, and click Next. Then skip to step 11 below to continue with your 
installation.

• If you want to choose custom installation settings, click the Custom radio button, and 
click Next.

9. If you chose a Custom installation, the Web Browsers screen displays. This screen lists all 
of the installed browsers on this computer that can be automatically configured to use 
Cachelink Connector (Netscape 4.0, 4.5, 4.6, 4.7, and 6.0, and Internet Explorer 4, 5, and 
6). Allowing all of your browsers to use Cachelink Connector ensures that all of the Web 
content you access is cached for use by other Cachelink users, regardless of the browser 
you are using. Ensure the browsers you want configured to use Cachelink Connector are 
selected, and click Next.

N O T E

Mangosoft recommends that you configure at least your default 
browser to use Cachelink Connector.

10. If you chose a Custom installation, the Cache Location and Size screen displays. 

The Cache Location defaults to C:\Program Files\Mango\Cachelink\WebCache. If you 
want to choose a different location, click the Change button, browse to the desired location, 
and click OK.

The Cache Size defaults to 3% of the total disk space available on the cache drive. You can 
increase or decrease the cache size. Because it will be caching content for itself and a 
number of Connector Clients, Mangosoft recommends you specify a cache size of 100 MB 
or more for Cachelink Connector.

When you have finished setting the cache location and size, click Next.

11. The Summary screen displays. You can verify the settings you chose for your Cachelink 
Connector installation.

• If you are satisfied with the settings, click Finish to complete the installation.
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• If you want to modify one or more settings, click the Back button, modify the desired 
settings, and return to this screen. Then click Finish.

12. The Cachelink Connector files are quickly copied and installed to their target directory on 
your computer. A success message displays when the installation is completed.

N O T E

If you received an error message, or your installation failed, 
ensure you met the requirements outlined at the start of this 
chapter. Once you are sure you meet these requirements, start 
the installation procedure again. If problems persist, check the 
readme.txt file which you can view during installation. If you 
cannot resolve your problems, contact Mangosoft Support as 
described in the Preface of this guide.

The installation program automatically configures commonly-used browsers you specify during 
the installation procedure to use Cachelink Connector if it finds them installed and ready to 
access the Internet. The installation program can automatically configure the following 
browsers to use Cachelink Connector:

• Internet Explorer versions 4, 5, and 6

• Netscape versions 4.0, 4.5, 4.6, 4.7, and 6.0

Other browsers can be configured to use Cachelink Connector the same way they are configured 
to use a proxy server for HTTP, by setting the browser’s HTTP proxy to point to the addr
127.0.0.1, and the port 8080. If you need to manually configure a browser to use Cachel
Connector, see the section titled ‘‘Manually Configuring Browsers” in Chapter 3.

Note that during installation, to optimize your system, Cachelink Connector also configur
your browsers to use HTTP 1.1.

Once you have finished installing Cachelink Connector on the Windows-based Connecto
System, you can configure your Connector Clients to point to the Connector system as t
proxy server.
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Configuring Connector Clients
Once you have installed Cachelink Connector, you need to configure the Connector Clients so 
they point to the Connector System as their proxy server. These Connector Clients will then rely 
on the Connector System to provide them with Internet access, as well as enabling them to 
participate in Cachelink caching.

N O T E

Configuring Connector Clients requires skills commonly 
associated with expert computer users. If you require 
assistance, contact your system administrator.

To set up a Connector Client to work with the Connector System as its proxy server:

1. Write down the IP address of the system on which you installed Cachelink Connector. The 
proxy server address setting on all Connector Clients will need to be the same as the IP 
address of the Connector System.

N O T E S

1. If you are using a DHCP server to dynamically assign IP 
addresses, you should write down the Computer Name 
(node name) of the Connector System. When IP Addresses 
are dynamically assigned, Mangosoft recommends you 
enter a static Computer Name when configuring Connector 
Client proxy server settings. 

2. If you use a DHCP server and would like to use a static IP 
address, ensure you choose one that is outside the range of 
addresses that are dynamically assigned by the DHCP 
server.

2. Write down the Remote HTTP Port that the Cachelink Connector software is using on the 
Connector System. You can view the Remote HTTP Port setting by choosing 
Start > Programs > Cachelink > Configuration, and clicking the Advanced tab (by default 
the port is set to 8081). The port setting on all Connector Clients will need to be the same 
as the Remote HTTP Port setting on the Connector System. 

N O T E

On rare occasions, users find their Connector System is running 
another application that uses the default remote HTTP port 
number (8081). If you find this is the case, you should change 
the port number on Cachelink or the other application to ensure 
proper operation. If two applications are using the same port 
number, you may see unusual behavior in the application that 
started later as it attempts to access a port already in use. If you 
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must use a different port number, verify you are choosing one 
that is not currently in use by another program. To change the 
port number on the Connector system, choose 
Start > Programs > Cachelink > Configuration, and click the 
Advanced tab. Enter the new port number in the HTTP Remote 
Port field, and click OK.

3. Go to the first non-Windows computer system that you want to configure as a Connector 
Client, bringing the IP Address and Port information with you.

4. Open a Web browser on that computer. Go to the screen or tab on the browser that allows 
you to modify connections, or LAN settings. This is often accessible from your brows
Options dialog box.

5. Click the check box that enables this browser to use a proxy server.

6. Enter the HTTP information for Cachelink as the proxy server:

• For the HTTP Address, enter the IP address of the Connector System.

• For the HTTP Port, enter the Cachelink HTTP Remote Port of the Connector System.

7. Click OK on the dialogs you have navigated through to activate your settings.

8. Configure the browser to use HTTP 1.1 through a proxy server. There is usually a check 
box for this setting on the browser’s advanced Internet options page.

9. Browse to one or more web sites to ensure this browser can access the Internet pro
using the Connector System as its proxy server. Once you are satisfied that the 
configuration is working, exit the Web browser.

10. If there are additional Web browsers on this computer, configure each of them to use
Connector System as their proxy server, then test them, as described in steps 4-9 ab

11. When you have finished configuring the browsers on that Connector Client to use th
Connector System as their proxy server, go to the next non-Windows system you wa
configure as a Connector Client.

12. Configure the Web browsers on this Connector Client as described in steps 4-10 ab

13. Continue to configure your Connector Client systems until they are all configured to 
the Connector System as their proxy server. If you have many non-Windows systems
may want two Connector Systems, so you can point half of them at one Connector Sy
and half at another, evenly distributing their load.

Getting Started with Cachelink Connector
There is no need to start Cachelink Connector. Cachelink Connector starts automatically
installation and runs in the background, quietly saving you time and money.

For information on the Cachelink user interface, see Chapter 1.
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For information on monitoring Cachelink Connector activity, see Chapter 2.

N O T E

Cachelink Connector does not provide an Activity Meter. This 
feature is only available on retail versions of Cachelink Pro.

For information on modifying Cachelink Connector settings, see Chapter 3.
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